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A web application or web service is a
software application that is accessible

using a web browser or HTTP(s) user
agent.
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INFORMATION A USER SHARES

Photos and other media
Age and gender

Biographical information (education, employment
history, hometown, etc.)

Status updates (also known as posts)
Contacts

Interests

Geographical location

Credentials




HOW DOES GOOGLE TRACK YOU ?

IG @HITECHHACKING

CHROME YOUTUBE MAPS HANGOUTS
Browser history, Videos watched, Locations visited, Contacts,
website visited uploaded place searched conversations
PHOTOS CALENDER SEARCH GMAIL
People and Upcoming plans, Querles searched Contacts, emolls
places tagged appolintments sent, emall content
> m
SHOPPING ADS NEWS
Prodects searched , Ads clicked, News sites viewed,

clicked on topic Intrested In storles read



DIGITAL FOOTPRINTS gi?\zg

|t is the information that exists online
about you and your activity.

Be Careful About —
- What you share

- Where you share
- With whom you share




DIGITAL FOOTPRINTS

are are two kinds of Digital Footprints -
*Passive Digital Footprint
*Active Digital Footprint

Be Smart About -
-Sites you visit

-Emails you open
-Links you click




“WOW TO PRESERVE YOUR  coo®

DIGITAL FOOTPRINT?

vAlways think long term before posting.
Avoid Making Virtual or Online Friends.
Keep your personal information private.

Verify the profile on different platforms like
Linkedin, Twitter, Instagram and Facebook.

Use privacy settings on social networking pages

Protect your privacy by updating the settings on
the Browser




CYBER RISKS

TABNABBING
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Safe Browsing

Use/Install Most Secure Internet Browser

~ Customize Your Security Settings

Block pop-up windows

Confirm Site’s Security (https vs. http, green colored padlock)
Be wary of clicking links in email or instant messages.

Only download software from sites you trust. Carefully
evaluate free software and file-sharing applications before
downloading them.

Keep your browsers up to date
Use Incognito Window or Private Browsing
Block pop-ups, plug-ins and phishing sites
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PHISHING

E-mail sent by online criminals to trick you into
going to fake Web sites and revealing personal
information.

In other words, It is the criminal attempting to
acquire sensitive information such as-

* usernames
e passwords
* credit card details




AMPLES OF PHISHING é%‘i%zg

WEBSITES

www.gmail.com
www.icicibank.com

www.bankOfindia.com

www.yah00.com
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Send out thousands Victims click on link in
of phishing emails email believing it is
with link to fake legitimate. They enter

website. personal information.

G PHISHING '

Build fake site.

Fraudsters compile
the stolen data and
sell it online or use it

* themselves.
Fraudsters




ow To Identify Fake ?;%aé

Phishing Website?

~ Verify the URL of the webpage.

Check the Padlock symbol. NTL pS //

Establish the authenticity of the website by

verifying its digital certificate.

To do so,

Double click on the Padlock symbol at the upper right or

bottom corner of your browser window.




m TO CHECK A WEBSITE IS gjif;;‘zg
GENUINE OR NOT?

bsite Reputation Checker

Free website reputation checker tool lets you scan a
website with multiple website services to facilitate the
detection of fraudulent and malicious websites.

*https://www.urlvoid.com/
»FEATURES

*Multiple Blacklists

*Threat Analysis

*Safety Report


https://www.urlvoid.com/

TYPE URLVoid in = 550
GOOGLE

[e)iclickjacking real example SGo G el st elaiiseator - e GheckiTE\WebSTteRsIVIalicion GdaginiSateziGheckatN oWl = 8

‘@ & https://www.google.com/search?newwindow=1&client=firefox-b-d&sxsrf=ALekk02kb [E)  90% oo T D

GOOgle fake websites detector X Q

soe
sse
sss

Q Al O shopping [E News [ Videos Images  : More Settings  Tools

About 9,40,00,000 results (0.50 seconds)

www.urlvoid.com ~

URLVoid: Check if a Website is Malicious/Scam or Safe/Legit

Free website reputation checker tool lets you scan a website with multiple website ... services

Whois - Screenshot - DNS Records - About

People also search for X
website safety check google check link safety

check a website unsafe websites

scamadviser fake oiefeuiffh

www.thesslstore.com > blog » 5-ways-to-determine-if-a... ¥

5 Ways to Determine if a Website is Fake, Fraudulent, or a Scam

The Favicon — Websites can put whatever icon they want in the tab. Domain Name — This is
part of the URL and it's trustworthy, as long as you know what you're ...

www.researchgate.net » figure » summary-of-fake-websit...

summary of fake website detection tools. | Download Table
Download Table | summary of fake website detection tools. from publication: A Comparison of
Tools for Detecting Fake Websites | As fake Website developers ...

. 21:06
f ‘ NG
H O Type here to search 28-04-2020 EZ




TYPE THE WEBSITE ?ﬁﬁzg
URL

[e)iclickjacking real example s [€) fakewebsitesidetector=Gos Cliaisle i o Walbisiis I Wbl [ Clildel<iiia Vet & kil Cehiein Saifs? Chiaeleis Mo = &

‘@ & https://www.urlvoid.com ) w b ()

QURLVOlD WHOIS ~ DNSRECORDS PING  SCREENSHOT  HEADERS HTTP/2 GZIP  #~

Website Reputation Checker

This service helps you detect potentially malicious websites.

Check the online reputation/safety of a website.
Q Try the new URL Reputation API by APIVoid.

Need to scan an IP address? Try [PVoid

Scan Website

Data submitted here is shared with security companies (terms of use).

21:08
&

28-04-2020




‘@ & https://www.urlvoid.com w ﬁ‘ b )

! Domain Reputation API

QURLVO|D WHOIS DNSRECORDS ~ PING  SCREENSHOT ~ HEADERS ~ HTTP/2  GZIP

Website Reputation Checker

This service helps you detect potentially malicious websites.
Check the online reputation/safety of a website

9 Try the new URL Reputation APl by APIVoid.

Need to scan an IP address? Try IPVoid

q Www.amazonin Scan Website

Data submitted here is shared with security companies (terms of use).




EPORT SUMMARY 5@

[eclickjackingjreallexampleSGoe es\detector=(Goog; Antreeln) ez Chigee e Mo = &

: O & https://www.urIvoid.com/scan/anwgzon.in/ 80% ) Y} X ()
A
Report Summary
Website Address Amazon.in
Last Analysis 10 daysago | & Rescan
Blacklist Status 0/35
Domain Registration 2005-02-11 | 15 years ago
Domain Information @ WHOIS Lookup | DNS Records | Ping
IP Address 54.239.33.92 Find Websites | IPVoid | Whois
Reverse DNS Unknown
ASN AS16500 AMAZON-02
Server Location 11(E) Ireland
Latitude\Longitude 53.3338 / -6.2488 @ Google Map
City Dublin
Region Leinster

4 , PARY
~ ) / ENG
H O Type here to search 28-04-2020




TO CHECK A WEBSITE IS é@?’fg

GENUINE OR NOT?

Nibbler
Nibbler is a free tool for testing websites.

https://nibblersilktide.com/



https://nibbler.silktide.com/

N\ SEARCH FOR NIBBLER ISR
€DAC

Q Al Q Shopping [ News [ Videos [J Images i More Settings ~ Tools

Page 2 of about 8,27,00,000 results (0.44 seconds)

nibbler.silktide.com ~

Nibbler - Test any website

Free tool for testing how good your website is, and what you can do to improve it. Check

accessibility, SEO, social media, compliance and more.

www.europol.europa.eu » activities-services » how-to-d... »

How to detect fraudulent sites selling fakes | Europol

Illicit websites might use images from a brand's most recent advertising campaign or from the
original website to boost their credibility. Websites selling counterfeit ...

www.hindawi.com s journals » scn v

Phishing Detection: Analysis of Visual Similarity Based ...

The malware also misaddresses users to fake websites or proxy servers. Attackers attached
malware or embedded malicious links in the fraudulent e-mails and ...
by AK Jain - 2017 - Cited by 50 - Related articles

www.semanticscholar.org » paper » Detecting-Fake-Webs...

[PDF] Detecting Fake Websites: The Contribution of Statistical ...

In light of these deficiencies, we propose the development of a new class of fake website

detection svstems that are hased nn statistical learmina thearv (SI T)



‘@ @ https;/nibblersilktide.com/en_US

Wnlbbler Home  About  Proversion

Test any website

Over 6,373,482 websites tested

...‘o ....
4§ ' .
e o7, .s. 4 \.3 4, 8 a,
\'° : . t.“’ 4 .'0 (AT P O
*e'd o '
s"' o oo ° o ' '-'\. o O el
0.“ ] . ' & . 8 i : .. .. :: ® ‘ ¢ .'. ¢ ) ......
) ', A ‘e ' ! ) (AKX |
uo..:.l.' ' ) g ".. ] ® » . b .. .o el ‘e ‘ ‘
" N : " o o0 " o o 8% p : ) :

f Terms  Privacy  Recentlytested = English (US) gsilktide




[ OTAWWWICE n

‘@ & https://nibbler.silktide.com/en_US e @ Y

w nibbler Home About Pro version

Test any website

http://www.amazon.in Test

Over 6,373,482 websites tested

Terms Privacy Recently tested English (US)

" . 21:54
O Type here to search ) g +9 [yl (] P ? 2 ENG 52

28-04-2020



ORT FOR THE SCANNE
WEBSITE

Oclickjacking reallexample s () fakewebsitesidetector=Goe N Wbt geeint fur s ‘ | SEWebsitereportormmied: Wl comfusisiicneiises
‘@ & https;//nibblersilktide.com/en_US/reports/www.amazon.in B - ©%

A
Report for www.amazon.in

Overview

Twitter
Overall - smain 5. i, 5 B Vi Analytics
The overall score for this website. Printabllity

rintabili

URL format
Accessibility Meta tags
How accessible the website is to o
mobile and disabled users. e

Mobile
See contributing tests ¥ m

Internal links m
Experience Amount of content m
How satisfying the website is likely <arver Eehadior
to be for users.

Populari
See contributing tests ¥ i i m

Images m
Marketing Page titles [10]
How WEI_l marketed and popular the Nibbler tested a sample of 5 pages from this Incoming links m
website s website at 4:40 PM on Apr 22, 2020 (IST). .

Domain age n
See contributing tests ¥

Freshness u
Terms Privacy Recently tested English (US)

v

- O Type here to search i *9 E B

%

28-04-2020




Browser Extensions




Netcraft

> The Netcraft Extension is a tool allowing easy
lookup of information relating to the sites you
visit and providing protection from phishing and
malicious JavaScript.




Features

Detailed site reports
» Risk Ratings
» Conveniently report suspected phishing &

fraudulent sites
» Protection against Cross Site Scripting (XSS)
» Protection against Phishing sites

» Protection against malicious JavaScript




TO INSTALL NETCRAFT <©DAC

@ google.com/search?newwindow=18rz=1C1GCEU_enIN855IN8558.ei=T5xTXcWDCcrf9QOmzZXgBgfig=netcraft+extension®og=netcraft+extefigs_|l=psy-ab.3.0.0l

Go gle netcraft extension 3 Q

Q. Al 2 Shopping E) News &) Images ] Videos { More Settings Tools

f

Netcraft Extension - Google Chrome

https://chrome google com/.. /netcraft-extension/bmejphbfclcpompohkggcje... =

Aug 4, 2019 - The Netcraft Extension is a tool allowing easy lookup of information relating to
the sites you visit and providing protection from phishing and ...

People also search for

netcraft extension firefox shedan extension

how to install netcraft adblockplus chrome extension
netcraft whois netcraft api

People also ask
What is Netcraft extension?

What is Netcraft used for?

A

What is anti phishing toolbar?
Feedback

Netcraft Extension - Phishing Protection and Site Reports
https://toolbar.netcraft.com/

The Netcraft Extension explained (Firefox and Google Chrome versions are similar). Key
features of the Netcraft Extension: Site Reports: Link to a detailed report ...




v to Copy a We... & ‘'Impossible to Ident... &% Dual Boot UEFI Win... @ What Is Web Shell... ¥ How to Mount a N... & Web Shell Archive |.. A2 How to Configure...

& chrome web store

Home > Extensions > Netcraft Extension

h] Netcraft Extension Ackl 1o Charcomie

Offered by: www.netcraft.com

% % % % # 127 | Productivity | & 54.453 users

Reviews Support Related

i Gampletank x +
< c 8 hitps//www.examplebdnk.com

www.examplebdnk.com
exampleban ST L7

i
Site Report

Welcoma

Please log in 1o resecure yg Rink Ratinn: O

Country: UK Site rank: 1,405,656
First soen: Jaruary 2019 Most: FTIPO0316171

The URL of the site

<

DIPS /AW eXamp1edInk comv
Add a reason

Your email address (to receive updates)

i @




W//' SCANNING RESULT OF WEBSITE cDAC
7 \\\\

C A Notsecure | coda.cc/product/product.php?id=4 @5 0 1% h e\ Paused ) § i

Risk Rating: 0

Site

{ : US
Country: US rank:

i First
seen:

Host:

Disable protection for this site

Report malicious URL:

he URL of tf
http://coda.cc/product/product.php?id= @

Your email address (to receive
updates):

HleTcraFT




HTTPS Everywhere (Chrome
Browser Extension)

'« "HTTPS" is a website protocol that ensures a site is secure
before you visit it.

The Chrome extension, HTTPS Everywhere, rewrites the
request you send to any website you want to visit in
Chrome so you can be sure your browser produces the
secure version of that site.




< & chrome.google.com/webstare/detail/https-everywhere/gcb)|

~ chrome web store

Home >

Extensions > HTTPS Ever|

HTTPS EveryV
Offared by: www.eff.arg

v i o i W 4,136 | So

mmkclmelpehlifjekcdonpmejbdp thl=en
EA Add "HTTPS Everywhere"?

It ean:

Read and change all your data on the websites you visit

whe

he . _

al & Communication =2 20874

- -
exarmple.com

Overview Reviews Related

| hitps:/s

hoep

fr @ B W Gy N Pausca & i

= Sign in

| Add to Chrome |




(e @ Not secure | 192.168.58.132

E Resume

Sh
AC

Paused @
a HET TIPS/ 000 o eer g 2010815

EVERYWHERE

HTTPS Everywhere is ON D

Encrypt All Sites Eligible is OFF

Unencrypted requests are currently allowed

Settings for this site

» fill the detail Change your preferences for encrypted connections

Disable HTTPS Everywhere on ti
Don't have account?

Username

Password



c

® HTTPS Everywhere | chrome-extension://gcbommkcimdlpchlifiekcdonpmejbdp/pages/cancel/index.html?originURL=http%3A%2F%2H92.168.58.132%2F

a EVERYWH

HTTPS Everywhere noticed you were navigating to a non-HTTPS pages

HTTP - Version: 2019.6.27
., Rulesets version for EFF (Full): 2019.8.13

EVERYWHERE
HTTPS Everywhere is ON D
Encrypt All Sites Eligible is ON O
Unencrypted requests are currently blocked

Settings for this site

Change your preferences for encrypted connections

Y & @ < n Paus .‘

send you to the HTTPS version instead. The HTTPS version is unavailable. M
likely this site does not support HTTPS, but it is also possible that an attacker
blocking the HTTPS version. If you wish to view the unencrypted version of th
page, you can still do so by disabling the 'Encrypt All Sites Eligible' (EASE) op
your HTTPS Everywhere extension. Be aware that disabling this option could

—
Disable HTTPS Everywhere on this site

See

View All
Rules

About HTTPS
Everywhere

your browser vulnerable to network-based downgrade attacks on websites you-vion:

URL:
http://192.168.58.132/

Open insecure page




Google Safe Browsing

e Google’s Safe Browsing technology examines
billions of URLs per day looking for unsafe
websites.

* Every day, it discover thousands of new unsafe
sites, many of which are legitimate websites
that have been compromised.
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< (<] & httpsy//transparencyreport.google.com/safe-browsing/search?url=www.cdac.in < = - - -

& Web Shell Archive |... 22 How to Configure... B ~dd windows Serv.

EEH How to Copy a We... Fl Win... @ What Is Web Shell... ‘@ How to Mount a M...

g v —

Safe Browsing: malware and ware Site status

INSERT THE
SUSPICIOUS

LINK' HERE Srowsing site status

Google's S .s of URLs per day locking for unsafe websites. Every day. we discover thousands of new unsafe sites, many of
which are legi. .npromised. When we detect unsafe sites, we show warnings on Google Search and in web browsers. You can search
to see whether a » ~us to visit.

Check site status

www.cdac.in Q.

arrer

talus

&@ No unsafe content found




c:mc

SITE HAS NO DATA IN
UEi s  GOOGLE DATABASE
S WHICH CREATES A
DOUBT ABOUT IT

: malware and ph

No available data







“’/ =S MV/ARIOUS TECHNIQUES USED BY
/N . HACKERS/CRACKERS TO RETRIEVE YOUR

“@ PASSWORDS

SHOULDER
SURFING

(‘"Jy Give passwords anyone over phone

(e
\‘f
Al
) ) ‘l" )
i\ ’

4 )

BRUTE FORCE DICTIONARY
ATTACKS ATTACK




SWITCH TO PASSPHRASE

MY PASSPHRASE
G Never judge a book by its cover

MY PASSWORD

P ni@66!C

GNeverjudge @ 600k b6y !ts cover




3EST PRACTICES TO KEEP é%‘i%zg

PASSWORD SAFE

Use a different Password for each Service

Use a long and complex Password

Change Password regularly

Do not use your passwords on a shared computer
Test your Password

Use Passphrase
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COAC

7‘ | iﬁ P Findin Options

O disable go to Open ' Block pop-up windows Bxceptons..
/ Warn you when websites ty to nstall add-ons Exceptions..
the top right corner
of the browser) >
Options > Privacy & iy FreorDdaColecionan Use
> We strive to provide you with choices and collct only what we need o provide and improve
Security > Firefox
D ata C 0" ec ti on an d ORI Firefox for everyone. W aways ask permision before receiving personal information,

Use and then

Privacy Notice

‘ Allow Firefox to send technical and interaction data to Mozila ~ Leam more

unc h ec k t h e b OoXesS as Allow Firefox to make personalized extension recommendations Leam more
yO U see b e I OoOWw: /. AllowFiefox toinstall and run studies View Fireforstudies

° d i sa b I e te I emet ry Allow Firefo to send backlogged crash reports on your behal Leam more
firefox




-irefox Content
Blocking settings,
go to Menu >
Options > Privacy
and Security >
Content Blocking
and then select
which mode you
want to use.

CDAC

0 Standard
Balanced for protection and performance. Allows some trackers so websites function

properly.
¥ Known trackers only in Private Windows
% Third-party tracking cookies
7 Cryptominers

) You will need to reload your tabs to apply
C' Reload Al Tabs

these changes.




i Sh
ABLE CONTENT BLOCKING &PAC

FOR SPECIFIC SITES

It’s easy to disable content
ocking for certain nttps://wwwenytimes.com
trusted sites. Simply enter Site Information for www.nytimes.com
the website URL, then & Connection ,
click the “i” icon to the left secure Comnection
of the address bar, then ) Content Blocking Strict 3¢

Blockable content detected on this site.

click the grey button to b ke ocking 5
”Turn Off BIOCking for This & Cookies Blocking Tracking Cockies »

S V4
Slte. 7 Turn off Blocking for This Site

turn off content blocking Dermissions 25

f| refox You have not granted this site any special permissions.

Clear Cookies and Site Data...




CRECK WHETHER YOU ARE g‘iizg

\SjJ  SHARING THE LOCATION

Location

Allow access to location on this device

If you allow access, you will enable Windows to use your device's
capabilities to determine your location and Microsoft will use your
location data to improve location services. Peopie using this device
will be able to choose if their apps have access to location by using
the settings on this page. Denying access blocks Windows from
providing location to Windows features, Microsoft Store apps, and
most desktop apps.

Location for this device is off

Allow apps to access your location

if you allow access, you can use the settings on this page to choose
which apps can access your device's precase location and location
history 10 enable location-based expenences such as directions and
weather. If you are signed in with a Microsoft account on this
device, your last known location is saved to the cloud, and shared
with other devices where you are signed in with your Microsoft
account. Denying access only blocks the apps listed on this page
from accessing your location.

Some desktop apps may still be able to determine your location
when settings on this page are off. Find out why
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) .CK FOR THE UPDATES gﬁiﬁ;‘,‘zg

®S) = REGULARLY

A\NNS

Windows Update
You'e up to date
Last checked: Today, 12:10

3

Feature update to Windows 10, version 1909

The next version of Windows is available with new features and security improvements. When you're ready for the update,
select "Download and install.”

Download and install

@ Pause updates for 7 days
Visit Advanced options to change the pause period

Change active hours
Currently 08:00 to 17:00

&

View update history
See updates installed on your device

@

Advanced options
Additional update controls and settings

)



PRIVACY SETTINGS IN
CHROME

e




M= Tk

M= i mcl o

M=y Imncogmnirto weirecl o

Histomys
Chowrrnloads

Boclkmarks

Pl N iy

Frimt...
Cast...
Fimnd...

MAAore tools

Edirk

— —

Ctrl -+
Ctrl +— Sknift=




“’ ttlngs tab will appear. Locate and ﬁi%zg

\

éﬁk . select Show advanced settings.

N

[M Security error » / £ Settings

C A [I chrome://settings

Chrome Settings

[ ] PR e S R I_FI\_'\"l_"III!:iI

History -
' if| Let anyone add a person to Chrome

e | Add person.. | Edit Remove | Impert bookmarks and sett

Settings

Default browser

| Make Google Chrome the default browser |

Google Chrome is not currently your default browser.

Show advanced setti n@




CDAC

protection, check or uncheck the boxes next
to each option.

[ Security en [ Security error * [ L Settings
o 4

= C A [ chrome:;/settings
Chrome Chrome Settings

Privacy
Content settings... Clear browsing data...
I Settings

Settings Google Chrome may use web services to improve your browsing experience, You may o

ence, You may of
services, Learn more

of| Use a web service to help resclve navigation errors
of| Use a prediction service to help complete searches and URLs typed in the address bi i the address b
of| Use a prediction service to load pages more quickly

Automatically report details of possible security incidents to Google

Protect you and your device from dangerous sites

Use a web service to help resclve spelling errors

Automatically send usage statistics and crash reports to Google

Send a "Do Mot Track” request with your browsing traffic
SENO 8 WO WO Irack FeEqussD WILN Parurn Drowsing trarmic




FACEBOOK PRIVACY




FACEBOOK CLONING



'hat is Facebook Cloning? ©°

MC

acebook cloning describes a technique in which
scammers create a fake Facebook profile by
using images and other information stolen from
a targeted user’s real Facebook profile.




SWHY WOULD SCAMMERS DO ISh

THIS?

Once the scammers have created a fake
profile, they can send friend requests to
people on the targeted person’s friends list.

At least a few of the victim’s friends may
accept this second friend request because
they mistakenly believe that the victim has
accidentally unfriended them.




TO PROTECT YOUR ACCOUNT é@%“é

FROM FACEBOOK CLONING

* Hide Your Friends List

To hide your friends list, open your profile and click on the
“Friends” tab. Then, click the pencil icon on the right side
and click “Edit Privacy”




¢® General
fj Security and login

ﬁ Your Facebook
information

[E Privacy
] Timeling and fagging

ED Stories
Location

=] Blocking
Language and region
E] Face recognition

0 Notifications
Mobie
Public posts

ﬂ Apps and websites
%) Instant Games

E Business integrations

I§] Ads

Payments

Privacy Settings and Tools

Your activity Who can see your future posts? Only me Edit
Review all your posts and things you're tagged in Use Activity Log
Limit the audience for posts you've shared with Limit Past Posts
friends of friends or Public?

How people canfindand ~ VWho can send you friend requests? Everyone Edit

contact you
Who can see your friends list? Close

Remember that your friends control who can see their friendships on their own
timelines. If peaple can see your friendship on another timeline, they'll be able to see it
in News Feed, search and other places on Facebook. If you set this to Only me, only
you will be able to see your full friends list on your timeline. Other people will only see
mutual friends.

Who can look you up using the email address you  Friends Edit
provided?
Who can look you up using the phone numberyou  Friends Edit
provided?

Chat U

"
[ ]

&



O PROTECT YOUR ACCOUNT FROMCDMC
FACEBOOK CLONING

Run A “Privacy Checkup”
If you click the “Lock” icon at the top right of

your Facebook profile, you can perform a quick
privacy checkup related to your posts, apps, and
profile. Wherever possible, ensure that they are
all set to “Friends” or “Only Me” rather than

“Public”




N

Privacy Checkup

Thanks for making some time for this. Now let's go through 3 steps to
help make sure you're sharing with the right people.

Posts

Whenever you post from News Feed or your profile, you can choose an audience to
control who sees it.

Who do you want to see your next post?

22 Friends «

Tip: You can change your audience each time you post

Learn More

Apps

Profile



TO PROTECT YOUR ACCOUNT 1.5

FROM FACEBOOK CLONING

* View your profile as “Public”
At this point, it’s probably a good idea to see

what your Facebook actually looks like to
somebody who is NOT your friend. To do this,
click the “Lock” icon again then click “Who can
see my stuff”. Now, click the “View As” link
under “What do other people see on my
timeline?”




n Tanya Sharma Q . Tanya  Home Find Friends  Create

Tanya Sharma

View as

Add Photo

Timeline » About Friends & Photos & Archive

Timeline Settings

PEOPLE YOU MAY KNOW

n Tanya Sharma Q . Tanya Home Find Friends (od (1]

[This is what your profile looks like to: @ Public

Tanya Sharma L]

Timeline About Friends Photos More ¥

DO YOU KNOW TANYA?

To see what he shares with friends, send him a friend request. & Add Friend




TO PROTECT YOUR ACCOUNT ©dAC

FROM FACEBOOK CLONING

heck Who Can See Your Photos

Click the “Photos” tab and open “Albums”. Some
types of album will have an audience selector

that allows you to set all of the images in the
album to “Friends” or “Only Me” in one click.




[1] Photos + Create Album ~ Add PhotosVideo 2

Photos of You  Your Photos  Albums

A Vidoos Timeline Photos

Who should see this?

& Only Me

v More Options




CDAC

>

Dig into Your Privacy Settings

can also check and change privacy related settings
via the “Privacy Settings and Tools” section.

0° General Privacy Settings and Tools
L) Security
Who can soe my stuff?
5} Privacy
("] Timeline and Tagging
@ Blocking
B} Language

Limit Past Posts

e Notifications Who can contact me? Who can send you Iriend requests? riends of Friends Edit
& Mobile

Who can look me up? Who can ook you up using the emall address vo ‘riends Edit
EY Pubic Posts

ﬂ Apps Wha can Jook you Up using the phone number you riends Edit
W Ads oo




PROTECT YOUR ACCOUNT FROM g@fgg

FACEBOOK CLONING

Be wary of any friend requests from people that you
are already friends with.

* If you receive one, check your own friends list to see if

you are still friends with the person. If so, the friend
request is likely to be from a cloned account.

* Alert your friend to the scam as soon as possible so
that he or she can take steps to deal with the issue.
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How to protect vyour
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facebook account from

Tirmaline - About Friends Photo=s Aschive

T — —— — g T — - N Soes

P o B w3 o o —
- L B e e et e T R
-

- == .”m“:- P a— Viewsr as

Tim=dine Settings

D 3
Hide your friends l

Check how your profile

list from the public P looks to the public
{ Settings — Frivacy { Actiwy lag —+ Vicew as )

«
o Limit the photos 6

=4 S Pvercry vou post online
Tmedne and aQoing

Siores

Loszsisony

Ao

Lang-Spo anc reg on
Faco rooognitson

Cw e Feagisecil

Utilize the privacy Ignore f delete friends
settings in the best way request from strangers
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For rmeacva Sateits ) Quearsos o
END [ TL-00Y Cyoor Secury
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A FAGEBOOK OFF ACTIVITY ~ cdAC

acebook says turning off the ‘Off-
Facebook activity’ result in the user
no longer seeing personalized

advertisements based on their daily
online activity.




o turn off ‘Off-Facebook’c®nC

activity sharing?

0 check which apps and websites have
been sharing your data with Facebook,
head over to Facebook Settings > Your
Facebook Information > Off-Facebook
Activity.




Settings

’-\
Y

4

General

Security and login

Your Facebook information

Privacy

Timeline and tagging

. Stories

Location

2 Blocking

Aa Language and region

'y
- Face recognition

ON OFF-FACEBOOK ACTIVITY ISP
CIMNC

Your Facebook information

You can view or download your information and delete your account at any time.

Access your information  View your information by category.

Transfer a copy of your
photos or videos

Download your
information

Activity log

Off-Facebook activity

Managing your
information

Transfer your photos or videos to another service.

Download a copy of your information to keep or to fransfer to
another service.

View and manage your information and some settings.

View or clear activity from businesses and organisations that
you visit off Facebook.

Learn more about how you can manage your information.

View

View

View

View

View

Vit o




Off-Facebook activity

Off-Facebook activity includes information that businesses and
organisations share with us about your interactions with them, such as
visiting their apps or websites. Learn more

S LELVIRP L

SHEIN-Fashion Shopping Online, Indiatimes.com and other websites or
apps have shared your activity with Facebook.

What is off-Facebook activity?

Off-Facebook activity includes information that businesses and
organisations share with us about your interactions with them. Interactions
are things such as visiting their website or logging in to their app with
Facebook. Off-Facebook activity does not include customer lists that
businesses use to show a unique group of customers relevant ads.

How did Facebook receive your activity?

When you visit a website or use an app, these businesses or organisations
can share information about your activity with us by using our business
tools. We use this activity to personalise your experience, such as showing
you relevant ads. We also require that businesses and organisations
provide notice to people before using our business tools.

How activity is shared with Facebook

AN MANAGE YOUR FACEBOOK

CDAC

What you can do

Manage your off-Facebook
activity

View activity shared with us by the
businesses and organisations that
you visit off Facebook.

Clear history

Disconnect off-Facebook activity
history from your account.

+ More options

N



A

Your off-Facebook activity Clear history

4

This is a summary of the 123 apps and websites t
activity.

at have shared your

o

o Some of your activity may not appear here. Learn more

SHEIN-Fashion Shopping Online
Received 26 May 2020

indiatimes.com
Received 25 May 2020

Nykaa — Makeup/Beauty Shopping
Received 25 May 2020

Myntra - Fashion Shopping App
Received 23 May 2020

JRN OFF-FACEBOOK ACTIVITY ©is®
LICK ON CLEAR HISTORY

COMC

More options

Access your information
View your information by category

Download your information

Download details of your off-
Facebook activity

Manage Future Activity

Choose whether your off-Facebook
activity is saved with your account

Help



s .
CAN DOWNLOAD THE INFORMATION AS
WELL

More options

S Access your information
View your information by category

o Download your information

Download details of your off-
Facebook activity

Manage Future Activity

Choose whether your off-Facebook
activity is saved with your account

Help




Prevent your Facebook Account from being Hacked mnsleses

: | FB account
s . Tlurny °“,"|;°g'_'ﬁ', ;M‘y",ts o Limit the privacy of data you post ~ | hacked
en you turn on login alerts, you wi e notified any time l“f.o‘%

Times News NETWORK
someone logs in to your account from a new computer or phone. BTN WAL
awareness.in * Who cansee my stuff?

Take advantage of the privacy settings available in your account. :
i Gurgaon: An HR executive

Enable Login Approvals ! Whoaneonamer [T } | e e

When you turn on login approvals, you'll be asked to enter a login
approval code each time you access your Facebook account froma

: known person who allegedly

¢ Whocanlookmeup? :
¢ hacked her Facebook account

Click edit button on the toip

¢ andtried toextract her personal

new phone or computer. = right corner and set your | ===~ e “ | ¢ details like address and phone
Add OpenPGP public ke privacy L | £ 0T

y P w | Acting on her complaint, an

PGP stands for Pretty Good Privacy and is used to encrypt email = 2 E &:’gﬁﬁ:&%ﬂiﬂg&

communications and receive encrypted notification emails. It COI‘Itr0| the { (punishment for identity theft)

requires two keys -- one public, the other private -- to protect ¢ and 66D (punishment for cheat-

i ing by personation by using

posts to be tagged in your timeline : comperrosourcoorthetnr

email. The sender needs to know the recipient's public key to
encrypt the message, and then the recipient uses his or her private

keytodecryptit

You get to decide whether

Timeline and Tagging Setings

: mation Technology Act.

Inspector Ram Kumar, SHO,

i Sector 17/18 police station, said

friends are allowed to post | ... =" ¢ ¥ha hackerirteracted with:har
Enable app passwords things on your Timeline or . « | i friendsusing her Facebook pro-
Go to App Passwords and have the tool generate unique not and also decide | mum==== = ¢ filetryingtoextractafew details

passwords for your apps instead of using your Facebook password.

whether you want to

i of the complainant from them.
: The complaint, which was filed

review posts that friends o “ | 2&?&“$ggcistisfﬁltwmecyber
Create your trusted contact list tag you in before they “ | We have tracked down the
¢ accused’s location with the IP

Trusted contacts are friends you can contact if you ever need

help getting into your Facebook account

appear onyour Timeline.

* Who can add things to
my Timeline?

i address and will arrest him
¢ soon,”said Kumar.

In a similar case, a woman

from Nepal has accused one of

« Who canseethings on myTimeline? £ Tier orirer neighbours, Wio &
Securtty Setings * Howcanlmanage tags people add and tagging suggestions? i also from Nepal, of creating a
Login Averts et on sbrt when mayone oge o your sccound fum an uecogeieed devkos o Beowaar : fake Facebook account and up-
M BI k- : loading her pictures on it. The
Login Approvals :::;T;uyw security by requiring a login approval code or securilty key In addition to your a n age 0 c l n g ! woman has also alleged that he
% s ks y i posted images of her family
Puslic ey Manage an OpsnPGP key on your Facebock pofle and enable sncrypled noticatons You can manage the pages, profiles etc., from viewing your profile ¢ ‘Fnemibers-on. the:sortal:media
App Passwords e skl st ol 10y ps e o gy Factock st og through this setting. i website.
hizmadiznse H The woman, who is living in
Recognised Devices Review which browsers you've saved as ones you ofien use i Sirhaul in Sector 17, filed a com-
R AT Change your password regularly | plinton Wodnesday at the Sc
, : tor17/18policestation,ontheba-
Whare Youre Loggedin  Review and manage where youe curmenty logged i to Facesook Don't use same passwords for all your accounts. The harder you i sis of which an FIR was regis-
E——— PR passwords the saferyouare : tered under section 354D (stalk-
i ing), 66C and 66D of the
Legacy Contact Choose & family member o close friend 1o care for your account If something happens 10 you. Information’l‘echnology Act.
Deactvate yoursccount  Choose whether ou want 1o keep your account actie or descivate

For any queries on Cyber Security
[ e WWW. Call us on Toll Free No.

- 4%5 Information Security Education & Awareness M IC=T=Ya21] Evborawachiiakondra. 1800425 6235 %ﬁ"@m

Handiing Computsr Securfty Incidents
gov.in between 10.00 AM to 6.00 PM or
give a missed call we will call back in 24hrs C mc

Ministry of Electronics and Information Technology hitp:/icert-in.org.in/
Government of India




a PREVENTION TIPS R

G Never Open E-Mail attachments With the file
extensions Such as VBS,SHS,PIF etc '

Never open Web-links in your e-mail. | Always use e-mail transaction
Always type links in Web browser through secured mail sites
| |
Never download anything from e-mail when ~ New viruses creep upon a daily basis.
the sender is unknown or the attachment Itis important that we do back up
has a doubtful name our valuable data files regularly
Check for spelling mistakes.
Fake job offer mails generally have
spelling mistakes and grammatical errors
Never trust the icons in the e-mail Never send your photograph through
attachment. The virus file may be shown e-mail to unknown persons,

as PDF file. , N = .
0 Don't respond to spam mails without
k | verificstion'of the e-mail arigin |




Always use secured Turn off all JavaScript Keep your OS and
web browsers which or Active X support in Browser software up

enables safe yvour web browser to date with the
browsing over before you visit latest versions and

internet > unknown websites security patches.

Q. f >

« Turn off ,
P

Optimize your Block Pop-ups and Make sure the URL of
browser's settings to scripts the websites has
protect your device “https://" or a

from malicious : _ padlock icon

attacks ' —
@ hitps://www,

@

Clear your browsing
activity on regular
basis to avoid threat
to confidential

informati
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THANK YOU!

STAY SAFE STAY SECURE

Dr. Neha Bajpai

nehakapoor@cdac.in
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